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® SKF is a registered trademark of the SKF Group.  
 

All other trademarks are the property of their respective owners.  
 
The contents of this publication are the copyright of the publisher and may not be reproduced 
(even extracts) unless prior written permission is granted. Every care has been taken to ensure the 
accuracy of the information contained in this publication, but no liability can be accepted for any 
loss or damage whether direct, indirect or consequential arising out of the use of the information 
contained herein. SKF reserves the right to alter any part of this publication without prior notice. 

 
 

General Product Information 

 
General information such as datasheets and catalogues are published on the Condition Monitoring 
Systems site on SKF.com. Supporting product information can also be downloaded from the SKF 
Technical Support self-service web portal. 
 

Product Support Contact Information 

 
Product Sales – For information on purchasing condition monitoring products, services and 
support on products out of warranty, please contact your local SKF sales office or distributor. 
 
How to request Technical Support – Please open a support case using the Technical Support 
group’s self-help portal at www.skf.com/cm/tsg. Once your support case is submitted, a 
technician will contact you to begin working on your issue. For urgent issues we are available at 
these times: 

 
• Monday through Friday, 5:00 a.m. to 4:00 p.m. Pacific Time  

Phone: +1 800 523 7514 within the US or +1 858 496 3627 outside the US. 
 

• Monday through Friday, 8:00 a.m. to 4:00 p.m. Central European Time 
Phone: +46 31 337 65 00. 

  

• Monday through Friday, 7:30 a.m. to 4.30 p.m. India Standard Time 
Phone: +60 16 699 9506. 

 
  

https://www.skf.com/group/products/condition-monitoring-systems
https://www.skf.com/group/products/condition-monitoring-systems
https://skftechnicalsupport.zendesk.com/
https://skftechnicalsupport.zendesk.com/
https://www.skf.com/group/support/skf-locations
https://www.skf.com/group/support/find-a-distributor
https://skftechnicalsupport.zendesk.com/
http://www.skf.com/cm/tsg
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1 Product description 

1.1 Introduction  
 

SKF @ptitude Analyst Thin Client Transfer dBX (TCTdBX) is a mandatory application 

used to configure the Microlog Analyzer dBX and store data to @ptitude Analyst. 

TCTdBX is a small application that deploys very easily without using the @ptitude 

Analyst interface.  

TCTdBX is compatible with platforms that support @ptitude Analyst v9 MR3. 

TCTdBX has one mode of communication:  

Direct communication with an @ptitude Analyst database – This method 

communicates with SKF @ptitude Analyst Transaction Server to transfer data directly 

to / from the @ptitude Analyst database, bypassing the @ptitude Analyst application 

interface.  

1.2 Launching @ptitude Analyst TCTdBX 
 

When SKF @ptitude Analyst TCTdBX is installed, it creates a shortcut in the SKF 

@ptitude Monitoring Suite software group. 

To launch TCTdBX: 

1. From the Windows Start menu, select the SKF @ptitude Monitoring 

Suite group. 

2. Select SKF @ptitude Analyst TCTdBX. 

At any time TCTdBX is started, if a connection to the Transaction Service cannot be 

established, a dialogue prompting you to specify the computer name and port for the 

Transaction Server will appear. For more information, see section Manage 

connections. 

Once connection with the Transaction Server has been established, the user is 

presented with the login dialogue. 
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Figure 1   TCTdBX User login  

TCTdBX login uses the same user accounts as @ptitude Analyst login.  

• Verify using Active Directory password – Select to use the Active 

Directory credentials.  

• Enter the appropriate username and password and click OK to launch the 

application. 

When TCTdBX is run for the first time – Specify the IP Address/device name and 

port for the Transaction Server used for communication with @ptitude Analyst. 

• To find the IP Address for the Transaction Server, from the 

Windows Start menu, open Command Prompt, type "ipconfig", and press 

Enter.  

If the Transaction Server is running on the same computer, then you can use 

"localhost" or "127.0.0.1" for the IP Address. 

• To find the device name select This PC > Devices and drivers.  

• To find the computer name, from the Windows Start menu, select PC Info. 

When running TCTdBX the first time after a fresh install, it is normal to get a warning 

that looks similar to this: 
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1. Click OK to configure the IP address and port number. 

 

 

2. Enter the IP Address and Port (default values are 127.0.0.1 and 8088) 

and click Test to confirm that the connection is working.  

3. Click Commit to save the entered values. 

To start the application in offline mode, click Offline. 

For more information about this dialogue and the offline mode, see Manage 

connections and Preferences.  
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1.3 Manage connections 
 

 

Figure 2   Connection settings  

If the Transaction Server is moved, using the File Transaction Server Settings 

function, you can set the new: Connections, Name, IP address and Port.  

This dialogue is presented when the application starts if a connection to the 

Transaction Server cannot be established. 

If you are logging in from a computer that should have access to the Transaction 

Server but is not located, make sure the SKF @ptitude Transaction Server service 

is running in Windows. 

 

It is also possible to specify the parameters used to log into the application and to 

use during operation in the profile. The Analyst Login specifies the name presented 

in the login dialogue each time this profile is used. The Selected Hierarchy and 

Operators Sets configure those initial values for the session.  

 

Select Authenticate using Active Directory credentials to verify the user using 

Active Directory credentials and specify the Domain of the Active Directory user. 

These values will be presented in the login dialogue along with the Analyst Login 

value. 

 

Click Commit to save the changes made. 

 

To create a new connection, click Add and in the newly opened window enter a 

meaningful name and specify the Active Directory parameters. 
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Test – Click to test the connection. 

Undo – Click to undo changes. 

Remove – Click to delete a connection. 

1.4 Preferences 
 

Select File > Preferences to open the preferences window. 

 

Figure 3   TCTdBX Preferences view 

• Upload Images/Notes – Specify the upload location. 

 

• Create log files – Select the box and specify location to save log files. 

 

• Create JSON (DL_/UL) files – Select the box and specify location to save 

JSON files. 

 

• Retain transfer files – Under standard operation, the downloaded device 

Route files (*.rot) and the Analyst upload data files (MAULF*.2) are removed 

after successful download/upload. By selecting this option, the system will 

preserve these files. This is useful when contacting the Technical Services 

Group to help resolve an issue. 

 

• Start up in Offline mode – With this option selected, when you start-up the 

application it will not communicate with the Transaction Server, and it will run 

with limited options available. Use this option when you want to connect to 

the device only and perform operations locally.  

 

• Require password when logging in – It will force the Login Dialog to 

appear and require you to enter the password. If unchecked, the password 

last used for the profile's username is used to authenticate. If the 

authentication fails (for example, if the password has been changed), the 

login dialogue is presented. 
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1.5 Hierarchy selection 
 

 

Figure 4   Hierarchy selection  

@ptitude Analyst data is organized into hierarchies. In @ptitude Analyst, each user 

must select a Primary Hierarchy to be used as the default. This same hierarchy is 

used by default when a user logs into TCTdBX. If necessary, you may change the 

hierarchy used by TCTdBX.  

Note: Changes to the Hierarchy selection are automatically saved to the active 

profile. 

To change the @ptitude Analyst hierarchy: 

1. Log in to TCTdBX. 

2. Select File > Open. The Open Database dialogue displays. The 

hierarchy currently in use is highlighted.  

3. If necessary, select a different hierarchy and click OK. 

 

For different sorting of the presented hierarchies, select: 

• Sort by name or 

• Sort by creation date 

  



DIRECT DATABASE COMMUNICATION 

Overview 

SKF @ptitude Analyst Thin Client Transfer dBX  

User Manual 

Revision B 

11 (40) 

 

 

2 Direct database communication 

2.1 Overview 
 

SKF @ptitude Analyst Thin Client Transfer dBX allows data to be uploaded to and 

downloaded from a Microlog Analyzer dBX by directly connecting with the @ptitude 

Analyst database via an optimized connection using the SKF Transaction Server. 

• You must log into TCTdBX from a computer with access to the Transaction 

Server. 

• Upload and download functionality using TCTdBX is almost identical to 

upload and download functionality using the @ptitude Analyst interface. 

 

 

Figure 5   TCTdBX architecture overview 

1. USB connection to Microlog Analyzer dBX 

2. Computer running Thin Client Transfer dBX 

3. Internet connection to Transaction Server 

4. Computers running Transaction Server / Database Server 

5. (Optional) @ptituce Analyst Client (for viewing data, reporting, database 

configuration) 

 

Establishing Communication with the Microlog Analyzer dBX Data Acquisition 

Device (DAD) 
 

Before transferring data to or from the Microlog Analyzer dBX, you must: 

1. Connect the device using the provided USB cable. 

2. Ensure that the cable drivers (USBCableDriver.exe) have been installed on 

the host PC. From the Windows Start menu, select Apps & Features and 

check if the driver is listed there. 

3. Put the device in Sync Mode, go to Utilities > Tools > Sync Mode. 

 

2 
1 

3 

5 

4 
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2.2 TCTdBX Database Communication on a Microlog 
Analyzer dBX 

 

The Microlog Analyzer dBX transfer function allows you to: 

• Download measurement point setups to the Microlog Analyzer dBX.  

• Upload collected data from the Microlog Analyzer dBX.  

• Check the Microlog Analyzer dBX status. 

• Configure, clear, or reset the Microlog Analyzer dBX.  

 

The Microlog Analyzer dBX communicates with TCTdBX using USB. 

To set up the Microlog Analyzer dBX for data transfer: 

1. Connect the Microlog Analyzer dBX to the client computer with access to 

TCTdBX. Refer to the Microlog Analyzer dBX User Manual for more 

information.  

2. From within TCTdBX, select Transfer > DBX <--> DB… 

3. The software automatically checks for a connection between the host 

computer and the Microlog Analyzer dBX. An alert dialogue displays if 

there is a connection error. This dialogue appears if the cable connection 

is: 

a. Not correct  

b. The device is not in Sync Mode  

c. The cable drivers are not installed properly  

4. Click OK at the message to continue. 

 

If a connection error occurs, the transfer dialogue title bar displays Microlog 

Analyzer dBX not responding. Once a connection is established, the transfer 

dialogue displays Microlog Analyzer dBX ready. 
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2.2.1 Download to a Microlog Analyzer dBX (DAD) 

 

The Download To DAD (Data Acquisition Device) tab of the Microlog Analyzer dBX 

transfer dialogue allows you to download measurement point setups from the 

@ptitude Analyst database to your data acquisition device. 

 

 

Figure 6   Download to DAD tab displaying Tree View 

Items available for download appear in the Select items to download table.  

Tree View – Select items to download from the Hierarchy, Routes, and/or 

Workspaces.  

• Click on the + signs to expand the tree. 

 If the Microlog’s internal clock does not match your system clock, TCTdBX 
will reset your Microlog’s clock as soon as communications are established. See 

the SKF @ptitude Analyst TCTdBX Installation Manual for more details on this 

configuration. 
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• A checkmark in the checkbox indicates all items in the Hierarchy, 

Route, or Workspace are selected. 

• A grey checkmark indicates some items are selected. 

• No checkmark indicates no items are selected. 

 

Route View – If you are only downloading Routes, use this view to quickly select the 

Routes. 

Routes are organised into six categories: Route Name, Due Date, Schedule Date, 

Last Download Date, Overdue Status, and Hierarchy.  

Note: Only complete Routes can be downloaded. 

Download Options – Select checkboxes to include in the download. Available 

download options vary depending on whether you are downloading to a Microlog 

Analyzer dBX.  

 

Download options for the Microlog Analyzer dBX are: 

• Force spectrum collection – Forces spectrum collection on every overall 

measurement. Use for baseline data collection and/or data collection before 

or after a machine overhaul (when collected spectra are necessary for every 

point). 

• Download spectral bands - Use this feature to download spectral band 

alarms for the downloaded points. 

• Download FAM information - Use this feature to download bearing fault 

frequency information associated with the downloaded points. 

Coded Microlog dBX notes are automatically included in a Microlog Analyzer 

dBX download. 

Operator sets – For more information, see Operator Sets.  

Hierarchy Name – If you select items directly from the Hierarchy list, they will appear 

as a specially named Route in the Microlog Analyzer dBX. 

• Assign a unique name in the Hierarchy Name text field for identification 

purposes. 

Download – Click to begin the download. The download progress displays in the 

progress bar. 

• The hierarchy specified on the Microlog Analyzer dBX must match the 

hierarchy currently selected in TCTdBX.  

If an error dialogue displays when the download process is initiated, check 

the dialogue’s Status tab to compare the Microlog dBX’s Data Source to the 

current TCTdBX hierarchy and configure the DAD’s status information if 
necessary. 
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2.2.2 Upload from Microlog Analyzer dBX (DAD) 

 

After completing the data collection, re-connect the Microlog Analyzer dBX and 

establish communications using the downloading procedure.  

At the TCTdBX Microlog Analyzer dBX transfer screen, select the Upload from DAD 

tab. 

 

 

Figure 7   Upload From DAD Tab 

 If the Microlog’s internal clock does not match your system clock, TCTdBX 
will reset your Microlog’s clock as soon as communications are established.  
The transaction server can also be configured to adjust the dates and times of 

any measurements being processed, provided those measurements’ dates and 
times fall outside the configured tolerance period. The software can be 

configured to create a new Event Log record and/or point Notes entry reflecting 

each adjustment. 

See the SKF @ptitude Analyst TCTdBX Installation Manual for more details on 

the configurations mentioned above. 
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Select items to upload or remove – Displays all Routes currently stored in the 

connected Microlog Analyzer dBX.  

• Select the Routes you wish to upload or remove. Use Ctrl+click to 

select multiple items. 

Brute Force – A Brute Force upload creates new Points (beneath a Non-Route set in 

the hierarchy) for all uploaded collector Points (even if the uploaded Points already 

exist in the hierarchy) and uploads all data into these new Points. 

• After selecting which Routes to upload, use this check box to select 

whether to use brute force to create new hierarchy Points for the 

uploaded data.  

Upload Measurement History – When data is collected on the Microlog Analyzer 

dBX for a Point that already has a stored measurement, there is an option to append 

the new measurement. If a new measurement is appended, the original 

measurement is added to an historical data file. Enable this check box to include 

historical measurements in the upload. Disable it to only upload the most recent 

measurement for each Point.  

Reset – After uploading, click to reset selected Routes. Use this option to clear 

collected data from the Microlog Analyzer dBX for the selected Routes, but leave the 

Route structure (SETs, Machines, and Points) and measurement instructions. This 

allows you to take data for a Route, upload it, reset the data, and then take data on 

the same Routes again. The reset option also downloads all operator names within 

the selected operator set to the Microlog Analyzer dBX.  

Remove – Click to remove selected Routes from the Microlog Analyzer.  

Upload – Click to initiate the upload process. Points are automatically processed into 

the hierarchy after the upload. Process status displays on the status bar.  
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2.2.3 Status 

 

The Status tab displays the connected Microlog Analyzer dBX’s status and 

compares the DAD’s current hierarchy with the current @ptitude Analyst hierarchy. 
Status information appears in the Device status information window.  

At the TCTdBX Microlog Analyzer dBX transfer screen, select the Status tab. 

 

Figure 8  The Microlog Analyzer dBX Dialog’s Status Tab 

The tab’s Configuration Parameters area allows you to select operator sets and 

download them to the DAD using the Clear and Reset buttons. 

Options include: 

Operator Sets – The Microlog Analyzer dBX DADs support operator names to tag 

measurement data with the corresponding operator’s name. Operator sets group 
several operators together.  

• If desired, select an operator set from the drop down list. The specified 

operator set downloads to the DAD when you click the Clear / Reset 

buttons. 

View Sets – Select this option to view the operators that are in a particular operator 

set. The View Sets dialog displays. 
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• Select a set from the drop down list. All operators included in the 

selected set display in the Operators area.  

• Click OK to return to the Status tab with the current operator selected in 

the Operator Sets field. 

Device status information includes: 

Hardware Version – The type of device (dBX). 

Firmware Version – The Microlog Analyzer dBX firmware version number. 

Serial Number – The serial number of the device. 

Internal Clock – Date and time from the Microlog Analyzer dBX’s clock. 

Free RAM – The percent of the Microlog Analyzer dBX memory that is free for 
storage. 

 

Routes – Displays the list of all Routes stored in the connected Microlog Analyzer 

dBX. 

The following buttons appear in this tab: 

Clear – Use this option to clear the entire Microlog Analyzer dBX. It erases all data, 

SETs, machines, points, Routes, Route instructions, non-Route points, operator lists, 

and coded notes stored in the Microlog Analyzer dBX. It does not change the DAD’s 
menu settings. After clearing the DAD, the Clear option downloads the specified 

operator list from the @ptitude Analyst Database to the DAD. 

 

Reset – After uploading, click to reset selected Routes. Use this option to clear 

collected data from the Microlog Analyzer dBX for the selected Routes, but leave the 

Route structure (SETs, Machines, and points), sequence, and measurement 

instructions. This allows you to take data for a Route, upload it, reset the data, and 

then take data on the same Routes again. The reset option also downloads all 

operator names within the selected operator set to the Microlog Analyzer dBX. 
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3 File transfer  

3.1 Overview  
 

SKF @ptitude Analyst TCTdBX allows you to upload and download data using files 

created on remote systems, without requiring a direct connection of the Microlog 

Analyzer dBX to the computer hosting @ptitude Analyst. It is used in situations where 

data collection occurs at a different location than the data analysis using @ptitude 

Analyst. 

 

Figure 9  TCTdBX File transfer architecture 

1. @ptidute Analyst database and TCTdBX 

2. Transaction using USB stick or e-mail 

3. Computer with TCTdBX connected to Microlog Analyzer dBX 

4. Transaction using USB stick or e-mail  

 

Use the following sequence of steps when performing file transfer: 

 

1. On a computer with access to the @ptitude Analyst database via the 

Transaction Server, the Program Manager uses TCT dBX's  

Transfer > File <--> DB option to create Route configuration files (*.ROT). 

 

2. Send those files using e-mail or USB memory stick to a computer with access 

to the Microlog dBX at the remote site. 

 

3. The Operator responsible for collecting data connects the Microlog dBX to 

that computer and uses TCT dBX's Transfer > DBX <--> File option to 

download those Route configuration files directly to the device. 

 

4. Collect the measurements on the Microlog dBX. 

2 3 

1 

4 
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5. Connect the Microlog dBX to the computer with TCT dBX and use the 

Transfer > DBX <--> File option to upload the files. 

 

6. The Operator then sends those files using e-mail or USB memory stick to the 

Program Manager. 

 

7. The Program Manager, on a computer with access to the @ptitude Analyst 

database using the Transaction Server, uses TCT dBX's  

Transfer \ File <--> DB option to upload the collected measurements to the 

database. 

3.2 File transfer to / from @ptitude Analyst database – 
File <--> DB 

 

File transfer to and from an @ptitude Analyst database allows you to create a file 
with data collection points that may be transferred to your remote site. Once data 
has been collected, it also allows you to upload resulting measurements back into 
@ptitude Analyst.  

 

To access the file to database transfer dialog, select Transfer > File <- -> DB… 

3.2.1  Generate download file 

 

 

Figure 10  File <- -> DB… – Generate Download File tab 
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The options available in this tab are similar to the ones in Download to a Microlog 

Analyzer dBX. 

 

Use the Generate Download File tab to create a download file that can be 

emailed to a remote site. This download file may contain multiple Routes, 

Hierarchies, or Workspaces. 

 

To download files: 

 

1. Click Browse and select a download location. 

 

2. Select Routes to download from the table. 

 

3. Select from the available Download Options. For more information about the 

options, see Download options for Microlog dBX.  

 

4. Click Download and follow the download process under Overall progress 

and Details. 

 

5. Now you can see the downloaded files in the selected download location. 

3.2.2 Import upload files 

 

 

Figure 11  File <- -> DB – Import upload files 

Use the Import upload files tab to upload processed files to @ptitude Analyst 

database. Once uploaded to the Analyst database, the files are processed by the 

Transaction Server and new measurements are stored for analysis. 
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To upload files: 

 

1. Click Browse and navigate to the location where your MAULF (Microlog 

Analyzer Upload Files) reside. 

 

2. To keep the files after processing, select Preserve upload files after 

processing. Or unselect the checkbox if you wish to delete them after 

processing.  

 

3. Select the files you wish to upload and click Upload. 

 

4. Follow the upload process in the Overall progress and Details bar.  

 

5. Now you can see the uploaded files in the upload window. 
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3.3 File transfer to / from Microlog Analyzer dBX – 
DBX <- - > File  

 

The files downloaded from the database can now be transferred to your  

Microlog dBX. To access the file to Microlog dBX transfer dialog, select  

Transfer > DBX <- -> File… 

3.3.1 Download to Microlog Analyzer dBX (DAD)  

 

Use the Download to DAD tab to save measurement files from @ptitude Analyst 

database to your Microlog dBX. 

 

 

Figure 12  DBX <- -> File – Download to DAD tab 

To download files to Microlog dBX: 

 

1. Click Browse and select the folder where you have previously saved your 

downloaded files. 

 

2. The files are now listed under Selected items to download. 

 

3. Select the files and click Download to save the files to your Microlog dBX. 
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3.3.2 Upload from Microlog Analyzer dBX (DAD)  

 

Use the Upload to DAD tab to upload files from your Microlog dBX to @ptitude 

Analyst database. 

 

 

Figure 13  DBX <- -> File – Upload to DAD tab 

To upload files from Microlog dBX: 

 

1. Click Browse and select an upload location. 

 

2. Select items to upload and click Upload. 

 

3. Follow the download process under Overall progress and Details. 

 

For more information about the other options available in this tab, see Upload from 

Microlog dBX. 
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3.3.3 Status  

 

Use the Status tab check different device status information. 

 

 

Figure 14  DBX <- -> File – Status tab 

For more information about Device status information, Routes and other available 

options, see Status. 
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Appendix A 

End-User License Agreement 
 

THIS END-USER LICENSE AGREEMENT (this “Agreement”) is entered into by and 
between SKF USA Inc. and/or SKF Condition Monitoring Center AB (hereinafter 

referred to collectively as the “Licensor”) and any person or business that executes 
this Agreement by clicking the “I agree” icon at the end of this Agreement or by 

accessing, using, or installing the Software (“Licensee” or “You”). Licensor and 
Licensee shall be referred to collectively in this Agreement as the Parties. 

 

BY CLICKING THE ACCEPTANCE BUTTON OR ACCESSING, USING, OR 

INSTALLING THE SOFTWARE, OR ANY PART THEREOF, YOU EXPRESSLY 

AGREE TO BE BOUND BY ALL OF THE TERMS OF THIS AGREEMENT. IF YOU 

DO NOT AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, THE BUTTON 

INDICATING NON-ACCEPTANCE MUST BE SELECTED, AND YOU MAY NOT 

ACCESS, USE, OR INSTALL ANY PART OF THE SOFTWARE. 

 

1. DEFINITIONS 

 

(a) Derivative Works. The Term “Derivative Works” shall have the same 
meaning as set forth in the U.S. Copyright Act, as amended from time to 

time, in title 17 of the United States Code. 

 

(b) Effective Date. The term “Effective Date” shall mean the date on which 
Licensee assents to the terms of this Agreement by clicking the “I agree” 
button at the bottom of this Agreement. 

 

(c) Intellectual Property Rights. The term Intellectual Property Rights shall 

mean all rights arising or protectable under the copyright, trademark, patent, 

or trade secrets laws of the United States or any other nation, including all 

rights associated with the protection of computer programs and/or source 

code. 

(d) Person. The term “Person” shall mean an individual, a partnership, a 
company, a corporation, an association, a joint stock company, a trust, a 

joint venture, an unincorporated organization, or a governmental entity (or 

any department, agency, or political subdivision thereof). 

 

(e) Software. The term “Software” shall mean the software application entitled 
Software for Wireless Monitoring System V/T, SKF @ptitude Analyst, SKF 

@ptitude Inspector, SKF @ptitude Observer, SKF @ptitude Decision 

Support or any other software within the SKF @ptitude family suite, which is 

an application developed, owned, marketed, and licensed by Licensor. The 

term Software shall include the object code of Software for Wireless 

Monitoring System V/T, SKF @ptitude Analyst, SKF @ptitude Inspector, 
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SKF @ptitude Observer, SKF @ptitude Decision Support or any other object 

code within the SKF @ptitude family suite and any and all user manuals, or 

other technical documentation, authored by Licensor in connection with 

Software for Wireless Monitoring System V/T, SKF @ptitude Analyst, SKF 

@ptitude Inspector, SKF @ptitude Observer, SKF @ptitude Decision 

Support or any other software within the SKF @ptitude family. The term 

“Software” includes any corrections, bug fixes, enhancements, releases, 
updates, upgrades, or other modifications, including custom modifications, to 

Software for Wireless Monitoring System V/T, SKF @ptitude Analyst, SKF 

@ptitude Inspector, SKF @ptitude Observer, SKF @ptitude Decision 

Support or any other software within the SKF @ptitude family suite and any 

and all user manuals. The term Software also includes any supplemental, 

add-on, or plug-in software code provided to Licensee in the course of 

receiving Product Support Plan services from Licensor. The term Software 

shall not be construed to include the source code for Software for Wireless 

Monitoring System V/T, SKF @ptitude Analyst, SKF @ptitude Inspector, 

SKF @ptitude Observer, SKF @ptitude Decision Support or any other 

software within the SKF @ptitude family suite. 

 

2. LICENSE 

 

(a)  Grant of License. Licensor grants Licensee, pursuant to the terms and 

conditions of this Agreement, a non-exclusive, non-transferable, and 

revocable license to use the Software in strict accordance with the terms 

and conditions of this Agreement, including any concurrent use, network or 

other limitations set forth in subsection (b) below. All rights not specifically 

granted by Licensor under this Agreement are retained by Licensor and 

withheld from Licensee. 

 

(b) Installation and Use Rights. Licensee shall use the Software only on its 

internal computer equipment, whether such equipment is owned, leased, or 

rented, at the Licensee’s principal business office. The following paragraphs 
govern your installation and use rights with regard to the Software, 

depending on the type of license you have obtained from Licensor. 

 

(i) If you obtained a stand-alone license of the Software, you may install 

one (1) copy of the Software on one (1) computer residing in your 

principal business office. 

 

(ii) If you obtained a network license of the Software, you may install one 

(1) copy of the Software on as many networked clients (workstations) 

as authorized by your network license, as set forth more particularly 

in the applicable purchase order or other ordering documents 

memorializing your license acquisition; provided, however, that all 

network clients (workstations) are connected to a single licensed 

database residing in your principal business office. 

 



APPENDIX A 

End-User License Agreement 

 

SKF @ptitude Analyst Thin Client Transfer dBX  

User Manual 

Revision B 

29 (40) 

 

 

(iii) If you obtained a network license of the Software, you may connect to 

multiple licensed databases, you may install the database-dedicated 

clients up to the total number of networked clients acquired by you 

under the applicable purchase order or other ordering documents 

memorializing your license acquisition. 

 

(c) Other Conditions of Use. Licensor understands and agrees that the 

Software works in conjunction and is compatible with database software 

licensed to you by Microsoft. Upon installation of the Software, the Software 

may detect an installed database software application from Microsoft, and if 

so, the Software will be fully installed. If no installed database software 

application from Microsoft is detected, the Software will not install until such 

time as Licensee installs a valid and Software compatible copy of a 

Microsoft SQL Server database and consents to the license terms of such 

database software application. If Licensee does not agree to the terms of 

the Microsoft SQL Server license, or if the Licensee fails to install such 

database software, the Software will not work. Licensee is responsible for 

maintaining a valid database license in accordance with the Microsoft 

license agreement at all times. 

 

(d) Restrictions on Use. Licensee may use the Software only for its internal 

business purposes and on the identified equipment on which the Software 

was first installed or for which it is otherwise licensed; provided, however, 

that Licensee may temporarily use the Software on a back-up system in the 

event that the primary licensed system is inoperative or test system not 

used for production but solely for the purposes of testing the Software. 

Licensee may not use the Software for any other purpose. Licensee shall 

not: 

 

(i)  permit any parent, subsidiaries, affiliated entities or third parties to 

use the Software; 

 

(ii) use the Software in the operation of a service bureau; 

 

(iii) allow access to the Software through any workstations located 

outside of Licensee’s principal business offices; 
 

(iv) rent, resell, lease, timeshare or lend the Software to any Person; 

 

(v) sublicense, assign, or transfer the Software or this license for the 

Software to any Person; 

 

(vi) reproduce, distribute, or publicly display the Software; 

 

(vii) make the Software accessible to any Person by any means, including 

posting on a web site or through other distribution mechanisms over 

the Internet; 
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(viii) reverse assemble, disassemble, reverse engineer, reverse compile, 

decompile, or otherwise translate the Software or prepare Derivative 

Works based on the Software; 

 

(ix) place, reproduce, or make available the Software on Licensee’s 
computer network if Licensee is only authorized by this Agreement to 

operate the Software on a single workstation; 

 

(x) exceed at any given point in time the total number of network clients 

authorized by the applicable purchase order or ordering document to 

use or access the Software; 

 

(xi) edit or modify the Software except as expressly authorized by 

Licensor, including altering, deleting, or obscuring any proprietary 

rights notices embedded in or affixed to the Software; 

 

(xii) use the Software in any manner that disparages Licensor or 

Microsoft, or use the Software in a way that infringes the Intellectual 

Property Rights of the foregoing parties; or 

 

(xiii) use the Software in a manner that violates any federal, state, or local 

law, rule or regulation, or use the Software to violate the rights of any 

third party, or use the Software to promote pornography, hatred, or 

racism. 

 

(e) Copies. Licensee, solely to enable it to use the Software, may make one 

archival copy of the Software’s computer program, provided that the copy 
shall include Licensor’s copyright and any other proprietary notices. The 
Software delivered by Licensor to Licensee and the archival copy shall be 

stored at Licensee’s principal business office. If you purchased a network 
license of the Software, you may install one additional copy of the Software 

on your network for the limited purpose of testing the Software’s operation. 
Except for the limited reproduction rights set forth in this paragraph, 

Licensee shall have no other right to copy, in whole or in part, the Software. 

Any copy of the Software made by Licensee is the exclusive property of 

Licensor. 

 

(f) Modifications. Licensee agrees that only Licensor shall have the right to 

alter, maintain, enhance or otherwise modify the Software. 

 

(g) Protection of Software. Licensee agrees that it will take action by 

instruction, written agreement, or otherwise as appropriate with any person 

permitted access to the Software to enable Licensee to comply with its 

obligations hereunder. Licensee shall maintain records of the number and 

location of all copies of Software. Licensee shall not provide, permit access 

to or use of, or otherwise make available any Software in any form without 
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Licensor’s prior written agreement, except to Licensee’s employees for 
purposes specifically authorized by this Agreement. Licensee understands 

and agrees that the source code for the Software is a valuable copyright and 

contains valuable trade secrets of Licensor. Licensee agrees not to discover 

or attempt to discover, or assist or permit any Person to discover or attempt 

to discover, by any means whatsoever the source code of the Software. 

 

(h) Licensor’s Audit Rights. Licensor shall possess the right to audit 

Licensee’s use of the Software to determine compliance with this Agreement 
(hereinafter referred to as “Licensor’s Audit Rights”). Licensor’s Audit Rights 
shall be exercised in accordance with the following paragraphs: 

 

(i) Notice of Audit. Licensor shall provide Licensee with at least five (5) 

calendar days advance written notice of its intent to exercise the 

Licensor’s Audit Rights. 
 

(ii) Conduct of Audit. The audit conducted by Licensor shall consist of a 

physical review of the computer hardware, software, and middleware 

operated by Licensee at its principal business office and any other 

office for which Licensor, in its sole and arbitrary discretion, deems an 

audit appropriate. Licensee shall provide Licensor with unrestricted 

access to its computer hardware, software, and middleware in 

connection with any audit conducted by Licensor. 

 

(iii) Costs of Audit. If Licensor’s audit uncovers a violation of this 
Agreement by Licensee, Licensee shall pay all costs and expenses 

incurred by Licensor in exercising the Licensor Audit Rights, 

including, without limitation, all attorneys’ fees and agent fees 
incurred by Licensor. If Licensor concludes that no violation of this 

License Agreement has occurred, Licensor shall bear all costs and 

expenses incurred in exercising the Licensor Audit Rights. If Licensee 

obstructs, restricts, or otherwise prevents Licensor from conducting a 

full and unrestricted audit, Licensee shall bear all costs and 

expenses, including attorneys’ fees, incurred by Licensor in enforcing 
this Section 2(h) before any court or judicial tribunal. 

 

(iv) Frequency of Audits. Licensor’s Audit Rights shall be exercised no 
more than two (2) times in any one calendar year.  

 

(i) Validity of Intellectual Property Rights. In any action, dispute, 

controversy, or lawsuit arising out of or related to this Agreement, Licensee 

shall not contest the validity of Licensor’s Intellectual Property Rights related 
to the Software. Licensee hereby agrees that it has had an opportunity to 

investigate the validity of Licensor’s Intellectual Property Rights, and 
acknowledges that Licensor’s Intellectual Property Rights related to the 
Software are valid and enforceable. 
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(j) Material Terms and Conditions. Licensee specifically agrees that each of 

the terms and conditions of this Section 2 are material and that failure of 

Licensee to comply with these terms and conditions shall constitute 

sufficient cause for Licensor to terminate this Agreement and the license 

granted hereunder immediately and without an opportunity to cure. This 

subsection 2(j) shall not be construed to preclude, or in any way effect, a 

finding of materiality with respect to any other provision of this Agreement. 

 

3.  LICENSE FEE 

The applicable licensee fees will be set forth in the quote issued to Licensee by 

Licensor or otherwise established in the applicable purchase order or other 

ordering documents memorializing your license acquisition. 

 

4.  OWNERSHIP 

 

(a) Title. Licensee understands and agrees that Licensor owns all Intellectual 

Property Rights related to the Software, including custom modifications to 

the Software, whether made by Licensor or any third party. Licensee agrees 

that this Agreement effects a license, not a sale, of the Software and that the 

first sale doctrine, as codified in 17 U.S.C. § 109, does not apply to the 

transaction effected by this Agreement. 

 

(b) Transfers. Under no circumstances shall Licensee sell, license, sublicense, 

publish, display, distribute, assign, or otherwise transfer (hereinafter referred 

to collectively as a “Transfer”) to a third party the Software or any copy 
thereof, in whole or in part, without Licensor’s prior written consent. Any 
Transfer effected in violation of this Section 4(b) shall be void ab initio and of 

no force or effect. 

 

5. MAINTENANCE AND SUPPORT 

Licensor may provide you with support services related to the Software called 

Product Support Plan (“PSP”) services. Use of PSP is governed by the policies 
and programs described in the PSP literature or other material from Licensor’s 
Product Support Department (hereinafter referred to as the “PSP Policies”) that 
may be updated by Licensor from time to time. If you select and pay for PSP, the 

PSP Policies shall be specifically incorporated into this Agreement by this 

reference. Licensee acknowledges that Licensor may use any technical 

information provided by Licensee in the course of receiving PSP services for 

Licensor’s business purposes, including for product support and development. 
Licensor will not utilize such technical information in a manner that identifies 

Licensee. 

 

6. CONFIDENTIAL INFORMATION 

Licensee agrees that the Software contains proprietary information, including 

trade secrets, know-how and confidential information (hereinafter referred to 

collectively as the “Confidential Information”), that is the exclusive property of 
Licensor. During the period this Agreement is in effect and at all times after its 
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termination, Licensee and its employees and agents shall maintain the 

confidentiality of the Confidential Information and shall not sell, license, publish, 

display, distribute, disclose or otherwise make available the Confidential 

Information to any Person nor use the Confidential Information except as 

authorized by this Agreement. Licensee shall not disclose the Confidential 

Information concerning the Software, including any flow charts, logic diagrams, 

user manuals and screens, to persons not an employee of Licensee without the 

prior written consent of Licensor. 

 

7.  LIMITED WARRANTIES 

 

(a) Licensor warrants that the Software will perform substantially in accordance 

with its documentation for a period of 180 days from the date of shipment of 

the Software; provided, however, that the foregoing warranty only applies if: 

(i) Licensee makes Licensor aware of any defect with the Software within 

seven (7) days after the occurrence of the defect; (ii) Licensee has paid all 

amounts due under this Agreement; and (iii) Licensee has not breached any 

provision of this Agreement. The foregoing warranty does not apply in the 

event that: (i) the Software and documentation have been subject to misuse, 

neglect, alteration, modification, customization, improper installation, and/or 

unauthorized repair; (ii) the Software or any associated software or 

equipment have not been properly maintained in accordance with applicable 

specifications and industry standards or have been maintained in unsuitable 

environmental conditions; or (iii) Licensee has used the Software in 

conjunction with other equipment, hardware, software, or other technology 

that created an adverse impact on the operation, functioning, or 

performance of the Software. 

 

(b) EXCEPT AS SET FORTH IN THIS SECTION 7 AND TO THE EXTENT 

PERMITTED BY APPLICABLE LAW, ALL EXPRESS AND/OR IMPLIED 

WARRANTIES OR CONDITIONS, INCLUDING BUT NOT LIMITED TO 

IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, 

MERCHANTABILITY OF A COMPUTER PROGRAM, INFORMATIONAL 

CONTENT, SYSTEM INTEGRATION, FITNESS FOR A PARTICULAR 

PURPOSE, AND NON-INFRINGEMENT, ARE HEREBY DISCLAIMED AND 

EXCLUDED BY LICENSOR. 

 

(c) The remedies set forth in this Section 7 are the exclusive remedies available 

to Licensee for any problem in the performance of the Software. 

 

8.  LIMITATIONS ON LIABILITY 

 

(a) Limitations and Exclusions. IN NO EVENT WILL LICENSOR BE LIABLE 

TO LICENSEE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 

CONSEQUENTIAL, PUNITIVE OR OTHER SPECIAL DAMAGES, LOST 

PROFITS, OR LOSS OF INFORMATION SUFFERED BY LICENSEE 

ARISING OUT OF OR RELATED TO THIS AGREEMENT OR THE USE OF 
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THE SOFTWARE, FOR ALL CAUSES OF ACTION OF ANY KIND 

(INCLUDING TORT, CONTRACT, NEGLIGENCE, STRICT LIABILITY, 

BREACH OF WARRANTY OR CONDITION, AND STATUTORY) EVEN IF 

LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 

DAMAGES. THE PRECEDING EXCLUSION AND DISCLAIMER OF 

DAMAGES SHALL APPLY TO ALL CLAIMS MADE BY LICENSEE 

RELATED TO OR ARISING OUT OF LICENSEE’s USE OF THE 
SOFTWARE, INCLUDING, BUT NOT LIMITED TO, CLAIMS ALLEGING 

THAT THE SOFTWARE, OR ANY COMPONENT THEREOF, FAILED OF 

ITS ESSENTIAL PURPOSE OR FAILED IN SOME OTHER RESPECT. 

 

(b) Acknowledgment. Licensee agrees that the limitations of liability and 

disclaimers of warranty set forth in this Agreement will apply regardless of 

whether Licensor has tendered delivery of the Software or Licensee has 

accepted the Software. Licensee acknowledges that Licensor has set its 

prices and entered into this Agreement in reliance on the disclaimers of 

warranty and the limitations and exclusions of liability set forth in this 

Agreement and that the same form an essential basis of the bargain 

between the Parties. 

 

9.  TERM AND TERMINATION 

 

(a) Term. This Agreement shall commence on the Effective Date and shall 

continue in existence until it is terminated in accordance with Section 9(b) 

below. 

 

(b) Termination. Licensor may terminate this Agreement and the license 

conveyed hereunder in the event that Licensee breaches any provision, 

term, condition, or limitation set forth in this Agreement, including but not 

limited to the license restrictions set forth in Section 2(d) of this Agreement. 

 

(c) Effect of Termination. Within ten (10) days after termination of this 

Agreement and the license granted hereunder, Licensee shall return to 

Licensor, at Licensee’s expense, the Software and all copies thereof, and 
deliver to Licensor a certification, in writing signed by an officer of Licensee, 

that all copies of the Software have been returned to Licensor and that 

Licensee has discontinued its use of the Software. 

 

10. ASSIGNMENT 

 Licensee shall not assign or otherwise transfer the Software or this Agreement 

to anyone, including any parent, subsidiaries, affiliated entities or third Parties, 

or as part of the sale of any portion of its business, or pursuant to any merger, 

consolidation or reorganization, without Licensor’s prior written consent. Any 
assignment or transfer effected in violation of this Section 10 shall be void ab 

initio and of no force or effect. 

 

 



APPENDIX A 

End-User License Agreement 

 

SKF @ptitude Analyst Thin Client Transfer dBX  

User Manual 

Revision B 

35 (40) 

 

 

 

11. FORCE MAJEURE 

 Neither party shall be in default or otherwise liable for any delay in or failure of 

its performance under this Agreement if such delay or failure arises by any 

reason beyond its reasonable control, including any act of God, any acts of the 

common enemy, the elements, earthquakes, floods, fires, epidemics, riots, 

failures or delay in transportation or communications; provided, however, that 

lack of funds shall not be deemed to be a reason beyond a party’s reasonable 
control. The Parties will promptly inform and consult with each other as to any of 

the above causes that in their judgment may or could be the cause of a delay in 

the performance of this Agreement. 

 

12. NOTICES 

 All notices under this Agreement are to be delivered by depositing the notice in 

the mail, using registered mail, return receipt requested, to the party’s last 
known principal business address or to any other address as the party may 

designate by providing notice. The notice shall be deemed delivered four (4) 

days after the notice’s deposit in the mail, if such notice has been sent by 
registered mail. 

 

13. CHOICE OF LAW 

 This Agreement (including all Exhibits), including its formation, execution, 

interpretation, and performance, and the rights and obligations of the Parties 

hereunder, shall be governed by and construed in accordance with the laws of 

the Commonwealth of Pennsylvania, without regard to any conflicts of law (or 

choice of law) principles thereof. 

 

14. CONSENT TO JURISDICTION 

 In the event that either party initiates litigation relating to or arising out of this 

Agreement, Licensor and Licensee irrevocably submit to the exclusive 

jurisdiction of the state or federal court in or for Philadelphia, Pennsylvania for 

the purposes of any suit, action or other proceeding relating to arising out of this 

Agreement or any transaction contemplated hereby or thereby (“Legal 
Proceedings”). Licensee further agree that service of any process, summons, 
notice, or document by U.S. registered mail to such Party’s respective address 
shall be effective service of process for any Legal Proceeding. Licensor and 

Licensee irrevocably and unconditionally waive any objection to personal 

jurisdiction and/or the laying of venue of any Legal Proceeding in the state or 

federal court in or for Philadelphia, Pennsylvania, and hereby further irrevocably 

and unconditionally agree not to plead, argue, or claim in any such court that 

any Legal Proceeding brought in any such court has been brought in an 

inconvenient forum and otherwise waive any and all objections to the forum. 

 

15. EXPORT CONTROLS 

 Licensee shall not export or reexport, directly or indirectly, the Software without 

complying with the export controls imposed by the United States Export 

Administration Act of 1979, as amended (or any future U.S. export control 
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legislation) and the regulations promulgated thereunder.  

 

16. GOVERNMENT END USERS 

 If Licensee is acquiring the Software for or on behalf of a subdivision of the U.S. 

federal government, this Section 16 shall apply. The Software was developed 

completely at private expense, is existing computer software, is a trade secret 

for all purposes of the Freedom of Information Act, is “restricted computer 
software” and in all respects proprietary data belonging solely to Licensor, and 
all rights are reserved under the copyright laws of the United States. Use, 

duplication, or disclosure by the Government is subject to restricted rights as set 

forth in subparagraphs (a) through (d) of the Commercial Computer Software 

Restricted Rights clause at FAR 52.227-19, or for DoD units, the restrictions as 

set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer 

Software clause at DFARS 252.227-7013. 

 

17. TRADEMARKS 

 Licensee agrees that SKF @ptitude Analyst, SKF @ptitude Inspector, SKF 

@ptitude Observer, SKF @ptitude Decision Support or any other software within 

the SKF @ptitude family suite and the trade dress, logos and other designations 

of source used by Licensor to identify the Software are trademarks or registered 

trademarks of Licensor. Licensee shall not use Licensor’s trademarks or service 
marks without the prior written consent of Licensor. If the Software contains any 

active links to web sites, you agree to maintain such active links and not redirect 

or modify them. 

 

18. GENERAL PROVISIONS 

 

(a)  Complete Agreement. The Parties agree that this Agreement is the 

complete and exclusive statement of the agreement between the Parties, 

which supersedes and merges all prior proposals, understandings and all 

other agreements, oral or written, between the Parties relating to the use of 

the Software. 

 

(b) Amendment. This Agreement may not be modified, altered or amended 

except by written instrument duly executed by both Parties. Any purchase 

orders or other ordering documents issued to Licensee by Licensor shall 

not have the effect of amending or modifying this Agreement, and shall only 

serve to memorialize the number of licenses or products ordered by 

Licensee. In the event of a conflict between the PSP Policies and this 

Agreement, the terms of this Agreement shall control. 

 

(c) Waiver. The waiver or failure of either party to exercise in any respect any 

right provided for in this Agreement shall not be deemed a waiver of any 

further right under this Agreement. 

 

(d) Severability. If any provision of this Agreement is invalid, illegal or 

unenforceable under any applicable statute or rule of law, it is to that extent 
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to be deemed omitted. The remainder of the Agreement shall be valid and 

enforceable to the maximum extent possible. 

 

(e) Read and Understood. Each party acknowledges that it has read and 

understands this Agreement and agrees to be bound by its terms. 

 

(f) Limitations Period. No action arising under, or related to, this Agreement, 

may be brought by either party against the other more than two (2) years 

after the cause of action accrues, unless the cause of action involves death 

or personal injury. 

 

(g) Attorneys’ Fees. In the event any litigation is brought by either party in 

connection with this Agreement, the prevailing party in such litigation will be 

entitled to recover from the other party all the costs, reasonable attorneys’ 
fees, and other expenses incurred by such prevailing party in the litigation. 

 

(h) Authorized Representative. The person installing or using the Software 

on behalf of Licensee represents and warrants that he or she is legally 

authorized to bind Licensee and commit Licensee to the terms of this 

Agreement. 

 

(i) Injunctive Relief. Licensee agrees that Licensor may suffer irreparable 

harm as a result of a violation of Sections 2, 4, 6, 10, 15, and 17 of this 

Agreement and that monetary damages in such event would be substantial 

and inadequate to compensate Licensor. Consequently, Licensor shall be 

entitled to seek and obtain, in addition to such other monetary relief as may 

be recoverable at law or in equity, such injunctive other equitable relief as 

may be necessary to restrain any threatened, continuing, or further breach 

by Licensee without showing or proving actual damages sustained by 

Licensor and without posting a bond. 
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Appendix B  

Configuration file and Command Line 
parameters 

This appendix describes the contents of the Analyst Thin Client Transfer dBX (TCT 

dBX) configuration file (AnalystThinClientTransfer.DBX.exe.config) as well as 

available command line parameter options.  

 

Parameter Values Description 

TS_Address 

Computer name or 

###.###.###.### 

Default: 127.0.0.1 

Computer name or TCP/IP 

address of computer 

running @ptitude Analyst 

Transaction Server 

TS_Port 
##### 

Default: 8088 

Port ID that the @ptitude 

Analyst Transaction 

Server is configured to 

listen to 

Last_Analyst_User 
Analyst account name 

Default: null 

@ptitude Analyst 

username last used to log 

into TCT dBX 

Last_Analyst_Hierarchy_ID 
#### 

Default: 1 

Last @ptitude Analyst 

hierarchy opened in TCT 

dBX 

Last_Analyst_Operator_Set 
####  

Default: null 

Last @ptitude Analyst 

Operator Set sent down to 

the dBX 

Last_TCT_Download_Option_Flags 
# 

Default: 7 

Last set of options sent 

down to the dBX  

0 = all options off 

1 = Force Spectrum 

Collection 

2 = Download Spectrum 

Bands 

3 = Bands + Spectrum 

4 = Download FAM 

Information 

5 = FAM + Spectrum 

6 = FAM + Bands 

7 = FAM + Bands + 

Spectrum 
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Parameter Values Description 

Microlog_Comms_Tag_ID_Character 
Character 

Default: ~ <tilde> 

Character used to define 

RFID tag for @ptutde 

Analyst route machine. 

For example: “~123~” 
would configure an RFID 

tag id “123” 

Microlog_Comms_Working_Directory Windows Directory 

Default: C:\Temp 

Directory where logs, 

download files and upload 

files are created 

MIcrolog_Comms_Support_Device 

_Id_InMessages 
True / False 

Default : false 

If true, the device Id will be 

included in any Microlog 

Communication Library 

messages displayed. For 

USB comms, this value 

will always be 0, so the 

default is to suppress the 

value 

Last_Transfer_Column_Selected Column ID 

Default: 0 

Number of the last selected 

Transfer Route List column ID 

(0 based). 

Last_Transfer_Column_Sort_Order 

0 = Ascending (least to most) 

1= Descending (most to 

least) 

Default: 0  

Order of sorting last selected 

for Transfer Route List 

column 

Microlog_Comms_Retain_Incompatible_ 

Point_ Configuration 

True / False 

Default : true 

 

Setting to configure Microlog 

Comms Library to handle 

incompatible point types 

based on Microlog dBX 

version. 

TS_Disable_Progress_Info True / False 

Default : true  

(*) Used as an interim 

solution for large Route 

configurations. Requires 

9.0.3061.3 or higher patch to 

Transaction Server v9 MR3. 

Command Line Parameters 

 

The following command line parameters are supported: 

Parameter Values Description 

-dev None 

Starts TCT dBX in development 

mode with enhanced messaging 

and logging 

-ts: 

<minus>ts<colon> 

ComputerName,PortId 

Exampe: -ts:127.0.0.1,8088 

Overrides the TS_Address and 

TS_Port configuration file 

parameters.  

Syntax is:   
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Parameter Values Description 

<minus>ts<colon>Address<co

mma>Port 

-u: 

<minus>u<colon> 
AnalystUserName,password 

Overrides the Last_Analyst_User 

configuration file parameter and 

provides a password for use for 

verification. 

Syntax is: 

<minus>u<colon>Username<co

mma>password 
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